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In This Version 

HP Operations Smart Plug-in for IBM WebSphere Application Server for HP Operations Manager for Unix 
contains new features, feature enhancements, and other changes. 

New Features 

• Support for distributed network deployer scenario for WebSphere Application Servers 6.1  

Logfile monitoring is not supported in this release. 

For more information about customer-related enhancements and software fixes, see Enhancements and 
Fixes. 

Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  
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http://h20230.www2.hp.com/selfsolve/manuals


http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/

Installation Notes 

Installation requirements, as well as instructions for installing WBSSPI, are documented in the Installation 
Guide for HP Operations Smart Plug-in for IBM WebSphere Application Server provided in Adobe Acrobat 
(.pdf) format. The document file is included on the product's CD or DVD media in the documentation 
directory.

Software and Hardware Requirements  

Before installing WebSphere SPI, make sure that your system meets the following minimum requirements: 

• Software  

— HP Operations Manager for UNIX: 8.28, 8.29, 8.30 

— WebSphere Application Server 4.0, 4.1: HP-UX 11.11, AIX 5.2, 5.3 , Solaris 8, Windows 2000 

— WebSphere Application Server 5.0: HP-UX 11.11, 11.23, 11.23 IA64, AIX 5.2, 5.3, Solaris 8, 9, 10 

— WebSphere Application Server 5.1: HP-UX 11.11, 11.23, 11.23 IA64, AIX 5.2, 5.3, Solaris 8, 9, 10, 
Windows 2000, 2003, 2003 IA64, Red Hat Enterprise Linux AS/ES 4.0 (32 bit), SuSe Linux ES 9.0 (32 
bit) 

— WebSphere Application Server 6.0: HP-UX 11.11, 11.23, 11.23 IA64, AIX 5.2, 5.3, Solaris 8, 9, 10, 
Windows 2000, 2003, 2003 IA64, Red Hat Enterprise Linux AS/ES 4.0 (32 bit), SuSe Linux ES 9.0 (32 
bit) 

— WebSphere Application Server 6.1: HP-UX 11.11, 11.23, 11.23 IA64, AIX 5.2, 5.3, Solaris 8, 9, 10, 
Windows 2000, 2003, 2003 IA64, Red Hat Enterprise Linux AS/ES 4.0 (32 bit), SuSe Linux ES 9.0 (32 
bit) 

— HP Reporter: 3.80 

— HP Performance Insight: 5.0, 5.1 

— HP Performance Manager (HP-UX, Solaris, Windows): 8.10 

— Service Navigator is not required to run the WBSSPI. However, if you want to view service maps, 
Service Navigator must be installed. 

Installation Problems 

— If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (HPOM 8.x 
only), you must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is 
free software available from http://www.sudo.ws. The OS-dependent software packages are available 
at the bottom of the download page (http://www.sudo.ws/sudo/download.html). 
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Enhancements and Fixes 

To display details about each software enhancement or fix, click the reference number link to go to the HP 
Software Online Support web site. The first time you click a link, you must enter your HP passport 
information. To set up your passport profile, go to: 

http://h20229.www2.hp.com/passport-registration.html

Fixes  

QXCR1000765253: DOC: WebSphere Application Server 6.1 : Update java SDK 1.5 to level “SR4” 

QXCR1000455084: Is the WBS discovery executes the wbsspi scripts as the superuser 

Known Problems, Limitations, and Workarounds

• Problem: Two or more versions of the WebSphere application server are running on a managed node 
and discovery does not correctly set the properties for the application server(s). 

Workaround 1:   

1 Verify the application servers are using non-conflicting ports. If you install an application server in a 
different home directory, the installer may choose a port used by an existing application server (even if 
you set the installer to auto-configure non-conflicting ports). 

2 If application servers are using the same bootstrap port, modify the port numbers so that each 
application server uses a unique bootstrap port. 

3 Run the Discover application. 

Workaround 2:  If you want to use the same bootstrap port, run the Configure WBSSPI application and 
do the following: 

1 Set the HOME, JAVA_HOME, VERSION, and other properties that are incorrectly set. 

2 Set a unique ALIAS for each application server using the same port. 

3 Unselect the AUTO_DISCOVER check box for the application server that is not running. 

4 Select Finish. 

• Problem: In a non-English environment, the message browser does not display error messages 
correctly. 

Workaround:  Change the character set of the WBSSPI Error Log template and redeploy the template. 
For example, change the character set from “Shift-JIS” to “Japanese EUC.” 

• Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig 
file are not created when running the SPI Discovery or Configuration applications.  The problem may be 
that the component opctranm may be hung.   

Workaround:  On the management server, run the following commands: 

ovstop ovoacomm 
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr* 
ovstart opc 

• Problem: When multiple managed nodes are selected when running the Discover WebSphere or 
Configure WebSphere applications, or if the Discover WebSphere and Configure WebSphere applications 
are run at the same time, the SPI may report errors for one or more selected managed nodes because the 
SPI configuration file (SiteConfig) for one or more managed nodes has been misplaced.  
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Workaround:  Run the Configure WebSphere application for each managed node that is reporting 
errors (run the application on each managed node one at a time). 

• Problem: When the Self-Healing Info application is run on a Windows managed node, the output file 
may be hidden. 

Workaround:  If you do not see the file, do the following on the managed node: 

1 Open Windows Explorer. 

2 From the Tools menu, select Folder Options.  

3 Click on the View tab.  

4 Under Hidden files and folders, select Show hidden files and folders. 

• Problem: The perl installed with the HPOM agent fails to find the HPOM perl modules if another 
application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at 
locations that do not include the HPOM perl lib location.   

Workaround 1: Set the PERL5LIB system environment variable: 

1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the HPOM perl lib path) to the 
PERL5LIB system environment variable.  

2 Kill the HPOM agent: opcagt -kill  

3 Restart the HPOM agent: opcagt -start  

4 Check the HPOM environment: ovdeploy -cmd set  

5 If the PERL5LIB variable is not set correctly in the HPOM environment but the system variable is set 
correctly, reboot the system. 

Workaround 2:  

1 Delete the PERL5LIB system environment variable.  

2 Reboot the system. 

3 Run the Discover application. 

Workaround 3: Run the discover script on the target node. Enter the following: 

1 cd /var/opt/OV/bin/instrumentation 

2 wasspi_wbs_perl –S wasspi_wbs_discovery.pl 

NOTE: The service map is not generated when the discover script is run locally (is not run from the 
HPOM management server). 

• Problem: The wbs.log file grows very large.   

Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In 
the SPIConfig file (located in /var/opt/OV/wasspi/wbs/conf/ or /var/opt/OV/conf/wbs/ on 
UNIX platforms and /usr/OV/wasspi/wbs/conf/ on Windows platforms), add the following: 

# maximum number of lines to save to the log file / run 
LOG_LINE_LIMIT=16667 
# maximum number of characters to save from each log file / run 
LOG_SIZE_PER_FILE_LIMIT=600000 

• Problem: Two Netscape Navigator browser windows are launched when running the View Graphs 
application. The top window obscures the OVPM function buttons in the lower window.  

Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator 
version 6.0 or higher. 
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• Problem: The Web browser cannot be launched from an operator action after you have correctly 
configured the WBS SPI as instructed in the “Configure the Management Server to Launch your Web 
Browser” task in chapter 2 of the HP Operations Smart Plug-in for WebSphere Application Server 
Configuration Guide.  

Workaround: 

1 Stop and restart the agent from a user other than root by entering the following commands on the 
managed node: 

opcagt –kill 
opcagt –start 

2 Run the operator action. 

• Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to 
graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh 
when new selections are made.  

For example, in the HPOM console after you drag and drop a managed node onto the WBSSPI Admin 
application View Graphs, Netscape appears and displays a blank WBS SPI graphing page where you can 
accept or change the following default selections: 

Server: MyServer_1

Graph Name:  Serverstat

Data Range: 7 Days (ending now) 

By clicking Draw, you successfully generate the graph.  

However, when you select a different server, let’s say MyServer_2, you see that the graph that appears 
after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1). 

Workaround: 

1 In Netscape from the Edit menu select Preferences•Advanced•Cache. 

2 In the segment labeled Document in cache is compared to document on network, select radio button 
Never. 

3 After successfully generating the first WBSSPI graph, for any subsequent graphs, always change a 
minimum of two selections to refresh the data; for example select a different server and a different 
graph; or select a different graph and a different date range. Any two differing selections work to clear 
the current graph data from the browser cache. 

NOTE: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when 
clicked, it may return the error: the parameter is incorrect. 

• Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message  

WASSPI-1: Unable to create the lock file /var/opt/OV/wasspi/wbs/datalog/ddflog.lck. File 

already exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or 
dsilog processes are hung. 

Workaround: On each Solaris managed node on which the problem occurs, do the following: 

1 In the /var/opt/OV/wasspi/wbs/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME property 
after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME explicitly sets 
the data logging program that is used (normally, the collector automatically determines the data logging 
program to use). 

If you are running OVPA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

If you are running CODA, set the property to the following value: 
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DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda 

2 Kill the hung ddflog_coda and ddflog or dsilog processes. 

Example excerpt from the SPIConfig file after setting the property: 

UDM_GRAPH_CAPACITY=50000 
UDM_PERF_CAPACITY=50000 
#--------- Dynamic definitions ----------- 
DATA_LOGGING_ENABLED=TRUE 
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

• Problem: The WBS SPI requires that PMI be enabled in WebSphere in order to gather metrics.  With 
WebSphere 4, the SPI automatically enables PMI if it is not enabled and sets the impact level of PMI to 
that required for the metrics that the user selects.  WebSphere 5 servers have no capability for PMI to be 
enabled except from the WebSphere console.   The WBS SPI will fail if it tries to monitor a WebSphere 5 
server that does not have PMI enabled. 

Workaround: Before configuring the SPI, use the WebSphere console and enable PMI. 

• Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring 
the SPI on the managed Linux node.  This happens because some of the configuration processes require 
uudecode to be present on the local node. 

Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the 
SHARUTILS package. 

• Problem: The "Start WebSphere" and "Stop WebSphere" applications fail on Windows nodes if the 
USER or SERVER<n>_USER configuration property is set.  The application is trying to run the "su" 
command, which is only available on UNIX. 

Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the 
SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes. 

• Problem: The SPI's configuration log …/wbs/log/config.log on a managed node grows without being 
managed for size.  Information is appended to this file whenever the SPI's configuration is run (either 
manually or when the discovery process finds a change that requires configure to run such as a 
WebSphere server being added or removed).  Unless there are frequent changes to the environment 
requiring reconfiguration, this should not be a problem. 

Workaround:  Manually delete the file if it gets too large. 

• Problem: For a managed node running Red Hat Linux 4, discovery and/or metric threshold monitor 
alarming is not functioning AND the following error message is found in the SPI error log: 

*** glibc detected *** double free or corruption: 0x0937d008 *** 

Workaround:  On the HPOM agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart 
the agent. 

• Problem: The WebSphere Application Server version 6.1 is supported on Windows platform only if the 
COLLECTOR_MODE is set to TRANSIENT (the default mode is PERSISTANT).  

Workaround: To set the COLECTOR_MODE to TRANSIENT, follow this step: 

Open the SPIConfig file present in /<OvAgentDir>/wasspi/wbs/conf/ directory and add the 
following line: 

COLLECTOR_MODE=TRANSIENT 

The TRANSIENT mode is resource intensive. 

• Problem: The output of Check WebSphere application displays date format in English, in all locales. 

There is no workaround for this problem, in the current release. 

• Problem: The Discovery times out on the node in a network deployer scenario.  

Workaround: Change the value for timeout for agtrep on the node. 
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1 Run the following command: ovconfchg –edit. 

2 Change the value of ACTION_TIMEOUT to a higher value so that Discovery does not timeout. 

For example: Change ACTION_TIMEOUT=3 to ACTION_TIMEOUT=20 (or more minutes). 

Documentation Errata 

The support for DCE agent is dropped for WBS SPI. Ignore any information on the DCE agent 
present in the manuals or online help. 

Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html

Legal Notices 

©Copyright 2008 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 
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The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

For information about third-party license agreements, see the %ovinstalldir%/license-
agreements/SPI directory on the product installation SPIDVD-ROM. 

Trademark Notices 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. 
Windows® is U.S. registered trademarks of Microsoft Corporation.  
Java™ is a US trademark of Sun Microsystems, Inc.  
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